This document pertains to Release 1.5 of Avid Xpress® DV for the Windows NT® operating system. It describes new features, compatibility issues with other Avid® products, hardware and software requirements, and software installation information.

Contents

Symbols and Conventions ............................................. 4
Hardware and Software Requirements ................................. 4
New Features .................................................................. 5
  Pre-Install of Avid Xpress DV Release 1.5 ....................... 5
  Pre-Install of Avid Xpress DV Tutorial Files .................. 5
  Registering Your Avid Xpress DV Release 1.5 Product ...... 5
  Upgrading to Avid Xpress DV Release 1.5 ....................... 6
New Configuration ......................................................... 6
16:9 Support ................................................................ 6
New Encoding Solution .................................................. 7
About QuickTime Reference Movies ................................. 7
  QuickTime Reference Export Options ......................... 8
  Exporting as a QuickTime Reference Movie ................. 10
Media Cleaner EZ .......................................................... 11
About OMF Interchange .................................................. 12
  Choosing an OMFI Transfer Method ......................... 13
Avid Unity MediaNet ............................................. 15
Avid Publishing Wizard ......................................... 16
Seek to Timecode Improvement ................................. 17
Viewing Recorded Media ....................................... 17
Documentation Changes for Avid Xpress DV Release 1.5 .... 20
Microsoft ASF and Real Media G2 ......................... 20
Avid Xpress DV Online Help ................................. 20
French and German Customers .............................. 20
Customer Support ........................................... 21
Determining System Drives ................................... 24
Eject Disk Warning with IDE System Drives ................. 26
External Drive Issues ....................................... 26
Avid MediaDock ............................................. 29
Avid StorEx .................................................. 29
Compatibility with Avid Video-Based Editing Products .... 30
Increasing the Paging File .................................. 30
Creating a Windows NT Repair Disk ......................... 31
Goodies Folder .............................................. 32
Special Notes ............................................... 33
Decks and Cameras ......................................... 33
Camera Limitations ....................................... 35
General Limitations ................................... 35
Using a Sony DVMC DA1 or DA2 Transcoder ............... 37
Black Striping Your Tape .................................. 38
Warning Regarding Your Application Key .................. 38
Screen Resolution ........................................ 39
Using Headphones with Avid Xpress DV ................. 39
Using the Volume Slider Display in the Windows NT
System Tray ........................................... 40
Using the Master Volume Slider in the Windows NT
Audio Mixer Application ............................... 41
Using an Audio Mixer ................................... 41
Audio Issues .......................................... 41

*Part 0130-04645-01 Rev. A*
Audio Tool Input Slider
Offspeed Play to Camera
Third-Party Applications
Sonic Solutions
RealPlayer
Canopus
Web Software
Suggestions for Optimum Performance
Documentation Changes for Avid Xpress DV Release 1.0
Avid Xpress DV Getting Started Guide
Avid Xpress DV Online Publications CD-ROM
Avid Xpress DV User’s Guide
The Avid Calculator
Video Display Adjustments
MediaLog and Avid Xpress DV
Avid Products Collaboration Guide Addendum
QuickTime Sorenson
QuickTime Sorenson Streaming
Other Avid Applications
AvidNet Transfer Tool
Special Notes
Avid EDL Manager
Special Note
Avid Unity MediaNet
Additional Notes on Operation
Audio
Bins
Editing
Effects
Export
Media Files
Recording
Third-Party Applications
Symbols and Conventions

This guide uses the following special symbols and conventions:

- **A note** provides important related information, reminders, recommendations, and strong suggestions.

- **A caution** means that a specific action you take could cause harm to your computer or cause you to lose data.

- **A warning** describes an action that could cause you physical harm. Follow the guidelines in the manual or on the unit itself when handling electrical equipment.

Hardware and Software Requirements

Avid Xpress DV requires the following system configuration:

- Windows NT Workstation Version 4.0 Service Pack 5 or 6
- Minimum of 128 MB of RAM

For information about the status of Avid products and Year 2000 Readiness, see the Avid Web site at www.avid.com/y2k. In order to be Y2K compliant, you will need at least Service Pack 5.

To verify the version of the operating system and RAM:

1. Double-click the My Computer icon.
   
   The My Computer window opens.

2. Choose About Windows NT from the Help menu.
   
   The About Windows NT dialog box appears and displays the version of Windows NT, the Service Pack, and available memory.

3. Click OK to close the dialog box.
New Features

This section describes the new features that have been added to Avid Xpress DV Release 1.5. The documentation shipped with this product has not been updated with these new features.

Pre-Install of Avid Xpress DV Release 1.5

Your Avid Xpress DV Release 1.5 application might have been pre-installed for you. If an Avid Xpress DV icon appears on your desktop, the application has been pre-installed. You can also click the Start button, point to Programs, point to Avid, and click Avid Xpress DV.

If an icon does not appear on your desktop or you cannot locate Avid Xpress DV from the Start menu, see the instructions in the Avid Xpress DV Getting Started Guide on page 1-12 to install or to reinstall the Avid Xpress DV application.

Pre-Install of Avid Xpress DV Tutorial Files

The tutorial files might have been pre-installed for you. If the Introducing Avid folder appears in the Avid Projects folder, the media files have been pre-installed. If they do not appear in the Avid Projects folder, see the instructions in the Avid Xpress DV Getting Started Guide on page 1-23 to install or to re-install the Avid Xpress DV tutorial files.

Registering Your Avid Xpress DV Release 1.5 Product

To register your Avid Xpress DV Release 1.5 product, go to www.avid.com/register/xpresdv/ and fill out the Avid Xpress DV Product Registration Form.
Upgrading to Avid Xpress DV Release 1.5

If you are an existing customer, you will need to uninstall the Avid Xpress DV Release 1.0 application.

To uninstall Avid Xpress DV Release 1.0:
1. Insert the Avid Xpress DV Release 1.5 application CD-ROM.
2. Click Installers.
3. Click Avid Xpress DV.
   The system will search for any existing Avid Xpress DV applications installed on your system.
   A dialog box appears with a check box selected to Uninstall the Avid Xpress DV application.
4. Click OK.
   The Avid Xpress DV Release 1.0 application uninstalls.

To install the Avid Xpress DV Release 1.5 application, follow the steps in the Avid Xpress DV Getting Started Guide on page 1-12.

New Configuration

Avid is offering two system solutions for Avid Xpress DV Release 1.5: an IDE-based system or a SCSI-based system. For specific information about IDE system drives, see “Determining System Drives” on page 24. For specific information about SCSI system drives, see Connecting Your Editing Equipment for the Avid Xpress DV Software or Appendix A of the Avid Xpress DV Getting Started Guide.

16:9 Support

The Avid Xpress DV system supports the display of some forms of native 16:9 media with the correct aspect ratio. When you shoot this “wide” format with a camera, the camera stores the media
anamorphically (into a standard 4:3 frame) as opposed to letterboxed. When you select the 16:9 option in Avid Xpress DV, the anamorphic 16:9 media is displayed (not letterboxed) in the Composer monitor, pop-up monitor, and the Title tool.

Titles and effects are also created in the correct aspect ratio.

To display 16:9 footage in your Composer monitor:
1. Click in the Composer monitor to make it active.
2. Choose 16:9 from the Clip menu.

A check mark appears next to the 16:9 option. The Composer monitor displays media as 16:9.

If you shoot footage as anything other than 16:9 and choose to display the Composer monitor as 16:9, the media will appear distorted.

New Encoding Solution

With Avid Xpress DV Release 1.5, Avid supports Media Cleaner® to export to all Web formats. You can now export to Media Cleaner in one step by exporting as a QuickTime™ Reference movie.

We have included a Media Cleaner EZ CD-ROM with Avid Xpress DV Release 1.5.

About QuickTime Reference Movies

A QuickTime Reference movie is a QuickTime movie that contains composition information but no movie data. Instead, the movie contains pointers to the original media in the OMFI MediaFiles directory on local or network media drives. Because the QuickTime Reference movie does not contain media, the file is much smaller than a QuickTime movie, usually only a few kilobytes per file. Therefore, exporting a sequence as a QuickTime Reference movie is faster and takes up less disk space than exporting a sequence as a QuickTime
movie. When you play back the movie in QuickTime Player, the movie references the media files.

QuickTime Reference movies are useful as long as you are working with Avid OMFI media files available on your local system or on an Avid Unity™ workgroup. Advantages are speed and small file size because the system does not copy the source media files into the exported QuickTime file. However, if you expect to move the exported QuickTime file to a system that doesn't have access to the media, you should use the standard QuickTime export so that the media files and QuickTime wrapper can be moved as one file.

QuickTime Reference Export Options

The following table describes the options in the QuickTime Reference Settings dialog box.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Use Marks</td>
<td>When this option is selected, the system uses current IN and OUT points in the selected clip or sequence to determine starting and ending frames for the export. To export the entire clip or sequence, deselect this option.</td>
</tr>
<tr>
<td>Use Enabled Tracks</td>
<td>When this option is selected (default), the system uses tracks that are enabled in the Timeline. To export the entire clip or sequence, deselect this option.</td>
</tr>
<tr>
<td>Flatten Video Tracks</td>
<td>When this option is selected, the composition is exported as one video track. When this option is not selected, one QuickTime video track is generated for each video track in the composition. Because most third-party applications do not understand multiple QuickTime video tracks, it is a good idea to select this option. This option is selected in the Fast Draft Defaults and the Digital Mastering Defaults.</td>
</tr>
</tbody>
</table>
Table 1 QuickTime Reference Export Options (Continued)

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Fill Spaces with Black</td>
<td>When this option is selected, blank spaces in video tracks are filled with black in the QuickTime movie. Because QuickTime movies do not recognize blank spaces, it is a good idea to select this option. When this option is not selected, a QuickTime movie might interpret spaces in the video track as gray or the background of the player. This option is selected in Fast Draft Defaults and Digital Mastering Defaults.</td>
</tr>
<tr>
<td>Render All Video Effects</td>
<td>When this option is selected, all unrendered video effects, including matte keys and titles, are rendered before export. When this option is not selected, any unrendered effects are ignored. This option is selected in Digital Mastering Defaults.</td>
</tr>
<tr>
<td>Premix Audio Tracks</td>
<td>When this option is selected, the audio tracks in the composition are mixed to two media files, which are exported. When this option is not selected, the original audio is exported. This option is selected in Digital Mastering Defaults.</td>
</tr>
<tr>
<td>Fast Draft Default</td>
<td>Choose this option for a faster export. This option automatically selects Flatten Video Tracks and Fill Spaces with Black. It automatically deselects Render All Video Effects and Premix Audio Tracks.</td>
</tr>
<tr>
<td>Digital Mastering Defaults</td>
<td>Choose this option to render all video effects and premix audio tracks before exporting the file. This option automatically selects Flatten Video Tracks, Fill Spaces with Black, Render All Video Effects, and Premix Audio Tracks.</td>
</tr>
<tr>
<td>Use Network Media References</td>
<td>When this option is selected, the exported movie uses the machine and share name of the media drive in the QuickTime Reference movie instead of a drive letter. Select this option when the media files referenced by the movie are accessed remotely over the network. If the media files are stored on the same drive as the QuickTime Reference movie, you do not need to select this option.</td>
</tr>
<tr>
<td>Add Shares for Media Drives</td>
<td>When this option is selected, the system creates a new drive share for referenced media files stored on unshared network drives. The drive share is hidden; that is, other users do not see the shared drive when browsing your computer. You do not need to select this option when media is stored on the same drive as the QuickTime Reference movie.</td>
</tr>
</tbody>
</table>
Exporting as a QuickTime Reference Movie

To export as a QuickTime Reference movie:
1. Select the material you want to export.
2. Choose Export from the File menu. The Export As dialog box appears.
3. Select the Export settings by doing one of the following:
   • Choose a setting from the Export Setting pop-up menu if you have created a setting in advance, and go to step 10.
   • If you want to review or edit a setting, go to step 4.
4. Click Options. The Export Settings dialog box appears.
5. Choose QuickTime Reference from the Export As pop-up menu.
6. Select settings as described in “QuickTime Reference Export Options” on page 8.

### Table 1 QuickTime Reference Export Options (Continued)

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pixel Aspect Ratio</td>
<td>The pixel aspect ratio allows you to apply a scaling to the video: square, 4:3, or 16:9. The pixel aspect ratio allows you to control the display format without modifying the source file. This feature creates metadata, additional data that is stored with the QuickTime movie. Some applications, such as the QuickTime Movie Player and Avid ePublisher, can interpret this metadata and scale the image at display time. Pixel aspect ratio is useful for QuickTime Reference movies because you do not modify the source files of referenced movies. For example, if your source movies are stored at the standard 720 x 486 for NTSC (720 x 576 for PAL), you can create two different QuickTime Reference movies that use the same referenced source files, one that uses 4:3 and another that uses 16:9. Pixel aspect ratio is useful for the Use Source Compression option because that option also preserves the original format.</td>
</tr>
</tbody>
</table>
7. Click Save As. The Save Export Setting dialog box appears.

8. Name the setting by typing a name of your choice in the Setting Name text box, and click OK.

The Export As dialog box appears with the default QuickTime Reference Movie name extension in the File Name text box.

9. (Option) Change the file name. In most cases, keep the default file name extension.

10. Select the destination folder for the file, and click Save.

   The file is exported.

   If a power failure or mishap occurs during the export process, the entire file is unusable. You need to repeat the export process. The only exception is a sequential file sequence, where all frames up to the point of failure are usable.

### Media Cleaner EZ

Media Cleaner allows you to turn clips and sequences into streaming media files. To use Media Cleaner with your Avid Xpress DV system, you should install Media Cleaner EZ from the CD-ROM provided by Avid. To run this application, use the serial number supplied on the label attached to the CD-ROM sleeve.

Avid Xpress DV supports Media Cleaner Pro 4.0.2 or later. If you have Media Cleaner Pro 4.0.2 or later installed on your system, you do not need to install Media Cleaner EZ to use Media Cleaner with your Avid Xpress DV system.

Media Cleaner provides you with the following settings options:

- QuickTime Progressive Download
- QuickTime Streaming
- RealG2 Web Download
- RealG2 Streaming
What's New for Release 1.5

• Windows Media™ - Video
• Windows Media - Audio
• AVI CD-ROM
• QuickTime CD-ROM
• Still Image

Media Cleaner also has a Settings Wizard, which guides you through the process of choosing the proper setting for your media.

To access Media Cleaner:

1. Click a sequence or clip in the bin.
2. Choose Send To from the File menu and then Media Cleaner.

A QuickTime Reference movie is created and automatically loads it into Media Cleaner. The Media Cleaner application starts.

For help using Media Cleaner, see the Media Cleaner User Manual.

About OMF Interchange

The OMFI Export window has changed for Avid Xpress DV 1.5. The following describes the OMFI file format and how to use it.

OMF Interchange® (OMFI) is a platform-independent file format that stores both the digital media (video, audio, graphics, animation) and the information describing how the media is edited together to form a final sequence. This editing information, called a composition, is the OMFI representation of the sequence created in your Avid system. The OMF Interchange format is the result of cooperative efforts of many industry and standards partners and Avid Technology, Inc.

Any other program that supports OMFI can read OMFI files, even if the program resides on a different computer platform. As a result, with OMFI you can transfer among different applications on different
platforms without worrying about cross-platform translations. This can be very effective for importing animation or audio files created on proprietary platforms.

**Choosing an OMFI Transfer Method**

OMF Interchange, as implemented in your Avid system, provides two basic methods for exporting files:

- **Method 1: OMFI compositions only**

  Your Avid system can export an OMFI file that contains only the editing information about a selected master clip or sequence. You then need to transfer both the OMFI file and the media files or to redigitize the media on the other system. After you have transferred the media once, you can transfer revised composition-only files, unless you consolidated the media (in which case, you must transport the media files as well).

  To export an OMFI composition only, select OMFI in the Export Settings dialog box and select Link to Video Media, Link to Audio Media, or both.

- **Method 2: OMFI compositions with media files**

  Your Avid Xpress DV system exports an OMFI file that contains all the editing information for the selected master clip or sequence along with the video and audio media files for that master clip or sequence.

  To export an OMFI composition with media:

  1. Select the file you want to export.
  2. Choose Export from the File menu.

    The Export Settings As dialog box appears.
  3. Click Options to open the Export Settings dialog box.
  4. Choose OMFI from the Export As pop-up menu.
  5. Select options as described in Table 2 on page 14.
6. Click OK. The Export As dialog box appears.

7. Select the destination folder for the file.

8. (Option) Change the file name. In most cases, keep the file name extension.

9. Click Save.

The file is exported and appears at the chosen destination.

### Table 2 OMFI Settings Dialog Box Options

<table>
<thead>
<tr>
<th>Suboption</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>OMFI Version 1.0</td>
<td>Select this option if the application to which you are exporting does not support OMFI Version 2.0.</td>
</tr>
<tr>
<td>OMFI Version 2.0</td>
<td>Select this option if the application to which you are exporting supports OMFI Version 2.0. If you are not sure, select 1.0.</td>
</tr>
<tr>
<td>Embed Video Media</td>
<td>Select this option to include (embed) video media in the OMFI composition; for example, if you plan to add video or film effects in an OMFI-compatible application.</td>
</tr>
<tr>
<td>Link to Video Media</td>
<td>Select this option when you use Method 1 (composition only).</td>
</tr>
</tbody>
</table>

Use the Embed WAVE, Embed AIFF-C, or AudioVision® Compatibility options if you plan to enhance audio in an OMFI-compatible application such as a digital audio workstation.

<table>
<thead>
<tr>
<th>Suboption</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Embed WAVE Audio Media</td>
<td>Select this option to export audio tracks in the WAVE format (.WAV file name extension) for audio files. WAVE media is embedded in the OMFI file. Use this option if you plan to enhance audio in an OMFI-compatible application such as a digital audio workstation.</td>
</tr>
</tbody>
</table>

Nearly all Windows® and Windows NT applications that support sound use WAVE files. QuickTime also supports the WAVE format.
Avid Unity MediaNet

Avid Unity MediaNet is a professional media network that significantly improves and simplifies the workflow of any digital content creation environment. By allowing simultaneous access to media throughout the production process, Avid Unity MediaNet enables truly collaborative digital media creation and dramatically improved workflow; it also enables dedicated systems to handle media management and manipulation tasks.

*Embed AIFF-C Audio Media*

Select this option to export audio tracks in the industry-standard AIFF-C format, which is compatible with many third-party sound editing and multimedia applications. Your Avid Xpress DV system does not compress audio media. AIFF-C media is embedded in the OMFI file.

*Link to Audio Media*

Select this option when you use Method 1 (composition only).

*AudioVision Compatibility*

Select this option when you want to transfer the OMFI compositions and audio to AudioVision.

---

**Table 2**  OMFI Settings Dialog Box Options (Continued)

<table>
<thead>
<tr>
<th>Suboption</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Embed AIFF-C Audio Media</td>
<td>Select this option to export audio tracks in the industry-standard AIFF-C format, which is compatible with many third-party sound editing and multimedia applications. Your Avid Xpress DV system does not compress audio media. AIFF-C media is embedded in the OMFI file.</td>
</tr>
<tr>
<td>Link to Audio Media</td>
<td>Select this option when you use Method 1 (composition only).</td>
</tr>
<tr>
<td>AudioVision Compatibility</td>
<td>Select this option when you want to transfer the OMFI compositions and audio to AudioVision.</td>
</tr>
</tbody>
</table>

---

*Avid Unity MediaNet is supported on English operating systems only.*

*Avid Unity MediaNet is supported with SCSI-based systems only.*

If you purchased Avid Unity MediaNet, you will need to install the Fibre Channel board. For the IBM® IntelliStation® M Pro 6868 system, the board should be installed in either slot 2 or 4.

If you have a second SCSI controller board installed, use slot 4 for the Emulex board. If you don’t have a second SCSI controller board installed, you can use either slot 2 or 4 for the Emulex board.
Your system should be set up with the following slots:

- Slot 1 – Empty
- Slot 2 – Secondary SCSI controller or Emulex (Avid Unity MediaNet)
- Slot 3 – DV Raptor® (1394 I/O) board
- Slot 4 – Emulex (Avid Unity MediaNet)
- Slot 5 – Primary SCSI controller

### Avid Publishing Wizard

The Avid Publishing Wizard is a tool that allows you to publish encoded streaming media files to a Web site.

To download the most recent version of the Avid Publishing Wizard, do one of the following:

If you have a Goodies icon on your desktop:
1. Click the Goodies icon on your desktop.
2. Double-click the Avid_Publishing_Wizard.html file and follow the instructions.

If you don’t have a Goodies icon on your desktop:
1. Install the Avid Xpress DV application CD-ROM.
2. Click Browse CD.
3. Double-click the Goodies folder.
4. Double-click the Avid_Publishing_Wizard.html file and follow the instructions.
Seek to Timecode Improvement

Avid has improved the amount of time it takes to seek to a timecode on a camera or deck, providing the device supports this feature and the tape has continuous timecode. If the device does not support this command or detects that the tape does not have continuous timecode, there will be no improvement in the amount of time it takes to locate a timecode on the tape. Some 1394 devices claim to support the Seek to Timecode command, but they are not frame accurate. If you continually encounter a “fail to find preroll” error, you can choose the “Generic_DVBasicDevice-NTSC” or “PAL” device in your Deck Configuration settings to disable this feature.

To ensure your tape has continuous timecode, follow the instructions for blackstriping on page 38.

Viewing Recorded Media

If you attempt to play back recorded media and you receive one frame of media and the remaining media is black, you might have the camera (or transcoder) cabled incorrectly or the Video Display settings in the software might need to be changed. If you understand the data path for the recorded data, you can easily set up the hardware or change the Video Display settings to fix the problem.

When you play back recorded media from one of your captured clips the software looks at the Video Display settings dialog box (see Figure 1) to determine where to get the data you want to display (play back).

Figure 1 shows the default Video Display settings. The settings are used by the software to define where the data comes from when you play back a clip. External video normally means a camera or transcoder is providing the data. Since External is selected, the software then looks at the External Video Source for the type of analog data to expect (the example shown is Composite).
Figure 1 Video Display Settings Dialog Box

The data flow for displaying recorded data using the Video Display settings in Figure 1 is explained in the following list and shown in Figure 2 (the numbers on the figure match the numbers in the list):

1. When you select play, the recorded data is sent through the FireWire connection to the camera or transcoder.

2. The data is decoded by the codec in the camera or transcoder.

3. The decoded data is sent back to the system as analog data as a Composite Out signal from the camera or transcoder to Composite In connection on the system.

4. The signal at the Composite In connection can now be used twice:
   - Monitored by the software for display in the Record monitor or the Display monitor.
   - Since the signal is jumpered internally between the In1 and Out1 port of the system, you can also view the data on a Client monitor if it is connected.
Figure 2  Data Path for Recorded Media

Now that you understand the data path of the recorded data, you can fix the playback problem if you receive one frame of media and the remaining media is black.

- The FireWire connection between the camera and the system is connected, but the analog connection between the camera and the system is not connected. When the system looks at the Composite In for the data, it isn’t there.

- The Video Display Settings dialog box is improperly selected. For example, you have connected Composite but selected S-Video. The software would be looking for the data at the In2 connection, not the In1 connection.

There are two other ways to fix the problem.

- Turn off the camera. The system determines there is no camera and uses the internal data.
• Select Internal video (client monitor disabled) in the Video Display settings dialog box (instead of External video).

Documentation Changes for Avid Xpress DV Release 1.5

The following features have changed since the Avid Xpress DV User’s Guide Release 1.0 and the Avid Xpress DV Getting Started Guide Release 1.0 were printed.

Microsoft ASF and Real Media G2

Please disregard any procedures associated with Microsoft® ASF and RealMedia G2 in Chapter 18 of the Avid Xpress DV User’s Guide. Also disregard any procedures associated with Microsoft ASF and RealMedia G2 in Chapter 10 of the Avid Xpress DV Getting Started Guide. Exporting to Microsoft ASF and RealMedia G2 are no longer available through the Avid Xpress DV Export dialog box. You can export to these applications through Media Cleaner EZ.

Avid Xpress DV Online Help

The Avid Xpress DV Online Help has been updated for this release. Information about Microsoft ASF and RealMedia G2 has been removed. Information about Media Cleaner has been added.

French and German Customers

Some shipments of Avid Xpress DV Release 1.5 contain a translated Avid Xpress DV Release 1.0 Online Publications CD-ROM that includes an earlier version of the translated Help and the Avid Xpress DV 1.0 Release Notes.

To check if you have the most up-to-date translated Avid Xpress DV Online Publications CD-ROM, at the top of the CD-ROM it should display “Release 1.5.” If the CD-ROM displays “Release 1.0,” you can
download the most up-to-date translated Help and *Avid Xpress DV What’s New for Release 1.5* (this document) from the Knowledge Center.

You will need to register as an Avid Xpress DV customer to gain access to this information. Once your registration is confirmed, you will have access to the Knowledge Center.

To access these files from the Knowledge Center:

2. Click Customer Service.
3. Click Knowledge Center.
4. Log in to the Knowledge Center.
5. Choose Avid Xpress DV.
6. Click the Documentation tab.
7. Click Software Guide.
8. Click Release 1.5.
9. Double-click the Avid Xpress DV 1.5 Help file (French or German).
10. Double-click the Avid Xpress DV 1.5 What’s New (French or German).

## Customer Support

The Avid Xpress DV system is supported by IBM and Avid. The following are guidelines on whom to contact for support.

For questions regarding the following items, contact the nearest IBM Help Center:

- Setup or operation of your IBM IntelliStation
- Missing components
- Cabling issues
• Installation of the Avid Xpress DV application

• Hardware parts replacement (except defective, lost, or stolen application keys)

For additional information, consult your IBM documentation or www.pc.ibm.com.

For operational questions regarding the Avid Xpress DV application:

• Avid offers 30 days of free technical support, beginning from the day you purchased your system.

• In the U.S. and Canada, contact Avid Customer Support at 800-800-AVID (2843) or 978-275-2476. In Europe, please contact your reseller or Avid International Information Desk at +44 1753 658 482. When you call, please have your system ID available, which can be found on the label attached to your application key.

Additional information on how to obtain support can be found at www.avid.com. Internet-based support is always available free of charge.

To access the Knowledge Center:

2. Click Customer Service.
3. Click Knowledge Center.

After 30 days, the following fee-based telephone information service is available.

**Avid Assurance**

• Annual Contract — Includes telephone support, maintenance releases, and software upgrades.
• Annual Contract option (available for international customers) —
  Telephone support only. Does not include maintenance releases
  and software upgrades.

To purchase Avid Assurance, or for more information in the U.S. and
Canada, please contact your reseller or call Avid Inside Sales at
800-949-AVID (2843), and then press option 6. For international
inquiries, please contact your reseller or call Avid International
Information Desk at +44 1753 658 482.

**Avid FlexSupport**

• Avid CallPak²:
  - 5- or 10-call package options

• Incident Support:
  - Per-event telephone support (U.S. only): 900-555-AVID

To purchase CallPaks in the U.S. and Canada, please contact your
reseller or call Avid Inside Sales at 800-949-AVID (2843). For additional
information regarding Incident Support, please call 800-800-AVID
(2843) or 978-275-2476 in the U.S. and Canada. For international
inquiries, please contact your reseller or call Avid International
Information Desk at +44 1753 658 482.

1Support offerings may vary by location. Consult your reseller or
www.avid.com for the latest information.

2Available in the U.S. and Canada only.

**Training**

For information on Avid Xpress DV courses, in North America, call
800-867-AVID (2843) or check our Web site at
www.avid.com/education.
In the U.K., contact Avid Authorized Education Centers (AAECs) directly:

- BBC Training & Development, Evesham, U.K.: +44 (0) 1386 420215
- VET Training, London, U.K.: +44 (0)171 505 4700

In Europe and Asia, visit our Web site at www.avid.com/education.

Avid Authorized Education Centers are required to meet rigorous Avid certification standards. All Avid authorized courses offered by AAECs are taught by Avid Certified Instructors using Avid authorized courseware to ensure consistent, quality Avid system training worldwide.

**Determining System Drives**

Avid offers Avid Xpress DV systems that contain either IDE system drives or SCSI system drives.

If you have a system with SCSI drives, see *Connecting Your Editing Equipment for the Avid Xpress DV Software* or Appendix A in the *Avid Xpress DV Getting Started Guide* for any information relating to SCSI installation.

Since systems with IDE system drives do not contain SCSI devices, all information pertaining to SCSI is invalid.

To determine which type of system drives you have, do one of the following:

- Look at the rear of the system and see if there is a SCSI board in one of the PCI slots (see Figure 3). If there is no SCSI board in the PCI slots, you have IDE system drives.
Figure 3  Avid Xpress DV (Rear View)

- Check the SCSI Adapters dialog box:
  
  a. Click the Start button, point to Settings, and then select Control Panel.
  
  b. Double-click SCSI Adapters.

  The SCSI Adapters dialog box appears, displaying the controller types on your system (see Figure 4).

  If two Intel® Ultra ATA Controllers appear, you have IDE system drives.
Eject Disk Warning with IDE System Drives

In the Avid Xpress DV application, do not choose Eject Disk from the File menu. This will hang your system and will cause you to lose unsaved data.

With the current release, the Eject Disk command allows you to select SCSI media drives only and make them inaccessible to Avid Xpress DV. This command does not work with IDE system drives.

External Drive Issues

Avid strongly recommends the use of Low-Voltage Differential (LVD) storage drives. If any other storage drive (fast wide, narrow) is added to the primary SCSI chain, the performance of the entire SCSI chain is affected. This drive performance can result in system instability and application errors such as failure of the system to boot properly, audio or video underruns, and chatter in the analog audio output.
The primary SCSI controller (PCI slot #5), supports a 9-GB internal LVD boot drive and an 18-GB LVD internal media drive. (The size of the drives might differ as larger drives are made available.) Only LVD drives should be attached externally or internally to this SCSI controller.

To determine if you have an LVD or non-LVD drive:

1. Connect only one external drive to your system.
2. Boot the system.

To determine if the drive is LVD or non-LVD:

- LVD will display ULTRA2-LVD after the SCSI ID #.
- Non-LVD will display ULTRA2-SE (for single-ended) after the SCSI ID #.

If you have both a non-LVD drive and an LVD drive attached, all SCSI ID numbers will display as ULTRA2-SE, regardless if the internal drive is LVD.

Connect only one drive at a time to determine the difference between LVD and non-LVD.

If you are using non-LVD drives, you will need an additional SCSI controller. This second SCSI controller should be installed in PCI slot #2. If you are going to use the second SCSI controller with non-LVD drives, you will need to change the maximum transfer rate for each SCSI ID to 20 megabytes per second (MB/s) using the SCSI BIOS.

Do not attempt to change the maximum transfer rate to the primary SCSI controller.

To change the Maximum Sync Transfer Rate (for non-LVD drive attachment to a second controller):

1. Reboot your computer.
2. When the message <<<Press Ctrl-A for SCSISelect Utility!>>> appears, press Ctrl+A.
This message appears early in the system boot cycle. As a result of the second SCSI controller being installed, the message will display twice. Pressing Ctrl+A during the display of either of the identical messages is acceptable and will allow the proper SCSI BIOS changes to be made.

3. Under the heading labeled Bus:Device, there will be two selections displayed (02:08h) and (02:0Bh). Press the Up Arrow and Down Arrow keys to select 02:0Bh, and then press Enter.

Do not make any adjustments to 02:08h; this is the primary SCSI controller and is preset at the factory for optimum performance.

4. Press the arrow keys to choose Configure, View Host Adapter Settings, and then press Enter.

5. Press the arrow keys to choose SCSI Device Configuration. Press Enter.

6. Press the arrow keys to choose Maximum Sync Transfer Rate for each of the 16 devices, and then do the following:
   a. Press Enter.
   b. Press the arrow keys to choose the value 20.0.
   c. Press Enter.

7. After all the transfer rates have been set to 20.0, press Esc (Escape) four times.

8. Select Yes, and press Enter to save the settings and exit the utility.

9. Press any key to reboot the computer.

After you install the second SCSI controller, there will be two external SCSI connectors on the back of the IBM IntelliStation. These are easily identified. The bottom SCSI connector (below the 1394 FireWire® board) is the primary (LVD only) controller. The upper SCSI connector (above the 1394 FireWire board) is the secondary controller, which is the appropriate place to connect non-LVD drives after making the SCSI BIOS setting changes.
For more information on the second SCSI controller or system settings, contact your reseller.

**Avid MediaDock**

MediaDock™ LVD SCSI IDs are hard coded on a per-slot basis. Because this could cause ID conflicts with internal drives on the primary SCSI controller, the MediaDock LVD is supported only when connected to the optional secondary SCSI controller.

**⚠️ When you are connecting a MediaDock LVD to the optional secondary controller, do not make changes to the SCSI BIOS. The maximum transfer rate should be left at 80 MB/s.**

Avid recommends the use of Avid rack-and-stack LVD media drives when removable shuttles (supported with the MediaDock LVD) are not required.

**Avid StorEx**

Avid StorEx is a general-purpose, hard-drive exerciser program. It verifies the operation of Avid SCSI hard drives connected to a SCSI board on a PCI-based Avid system.

*Avid StorEx tests only Avid hard drives.*

The program also provides test status information that is helpful for troubleshooting a drive problem. Avid Customer Support might instruct you to use StorEx as part of the process of troubleshooting a problem with a hard drive.

The StorEx utility is included on the Avid Xpress DV CD-ROM. The StorEx executable is located in the Utilities folder. Double-click the StorEx.exe file to run StorEx. In the Goodies folder is a ReadMe file with information about StorEx.
Compatibility with Avid Video-Based Editing Products

For detailed information on transferring projects to Avid Xpress DV, see the Avid Products Collaboration Guide Addendum and the Avid Products Collaboration Guide located on the Avid Xpress DV Online Publications CD-ROM.

For up-to-date information on the Avid Products Collaboration Guide:
2. Click Customer Service.
3. Click Knowledge Center.
4. Log in to the Knowledge Center.
5. Choose Avid Xpress DV.
6. Click the Documentation tab.
7. Click the link for the Avid Products Collaboration Guide.

Increasing the Paging File

Avid Xpress DV systems ship with a paging file on the internal drive. You might need to increase the paging file if you receive an “out of virtual memory” or “low virtual memory” message.

To increase the paging file:
1. Click the Start button, point to Settings, and then click Control Panel.
2. Double-click System.
3. Click the Performance tab in the System Properties dialog box.
4. In the Virtual Memory section, click Change.
5. Set Maximum Size to the size of physical memory (210 MB).
6. Click Set.
7. Click OK to close the Virtual Memory dialog box.
8. Click OK to close the System Properties dialog box.
   A message box asks if you want to restart your computer.
9. Click Yes.

Creating a Windows NT Repair Disk

The Windows NT Repair Disk is essential to successful restoration of a user system in the event of a damaged operating system component. The emergency repair disk (ERD), as it is sometimes called, should be updated any time a change to the operating system occurs. This can happen whenever hardware is added or applications have been installed.

The repair disk does not restore applications or device drivers. Instead, it holds copies of the user environment, software associations, passwords, and information about the system configuration.

Avid strongly recommends creating an emergency repair disk before you start the Avid Xpress DV application. For information on creating an emergency repair disk, see the Windows NT Help system or the documentation provided with your IBM IntelliStation system.
Goodies Folder

The Avid Xpress DV CD-ROM includes a Goodies folder. This folder contains third-party applications or plug-ins you can use.

To access or open the Goodies folder:

1. Click the Goodies icon on your desktop, or
2. Install the Avid Xpress DV application CD-ROM.
3. Click Browse CD.
4. Double-click the Goodies folder.

The information in the Goodies folder is provided solely for your reference and as suggestions for you to decide if any of these products fit into your process. Avid is not responsible for the manufacture, support, or sales of these products. Avid is also not responsible for any loss of data or time or any other adverse results related to the use of those products. All risks of using such products or accessing such Web sites are entirely your own. The Web sites listed in the Goodies folder are not under the control of Avid, and Avid is not responsible for their content, any changes or updates to them, or the collection of any personal data or information by the operators of such sites. All information and product availability is subject to change without notice.
Special Notes

This section contains important information about system-level changes that affect the way your Avid Xpress DV system software and hardware operate.

Decks and Cameras

Table 2 lists the cameras, decks, and transcoder currently tested by Avid. Not all cameras performed the same when tested. Table 3 lists specific issues with each of these cameras (see “Camera Limitations” on page 35).

The list of digital cameras, decks, and transcoder might change periodically.

For up-to-date information on decks and cameras:

2. Click Customer Service.
3. Click Knowledge Center.
4. Choose Avid Xpress DV.
5. Click the Documentation tab.
6. Click Hardware Guides.
7. Click Release 1.5.
8. Click Supported Cameras.
### Table 3  Avid Tested Cameras, Decks, and Transcoder

<table>
<thead>
<tr>
<th>Camera, Deck, Transcoder</th>
<th>Manufacturer</th>
<th>Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>Analog Decks</td>
<td></td>
<td>For an updated list of supported analog decks, click the Customer Service link at <a href="http://www.avid.com">www.avid.com</a> and then click Knowledge Center. Search for “Supported Decks.”</td>
</tr>
<tr>
<td>Digital Decks</td>
<td>Sony®</td>
<td>• GV-D300</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• GV-D300e</td>
</tr>
<tr>
<td>Transcoder</td>
<td>Sony</td>
<td>• DVMC DA1</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• DVMC DA2</td>
</tr>
<tr>
<td></td>
<td></td>
<td>(NTSC only)</td>
</tr>
<tr>
<td>Cameras</td>
<td>Sony</td>
<td>• DCR-VX1000</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• DCR-TRV900</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• DCR-TRV310</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• DCR-VX1000e</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• DCR-TRV900e</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• DCR-TRV310e</td>
</tr>
<tr>
<td>Canon®</td>
<td></td>
<td>• XL1</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• DM XL1</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• ELURA™</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• DM MV20 ELURA</td>
</tr>
<tr>
<td>Panasonic®</td>
<td></td>
<td>• PV-DV910</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• AG-EZ30U</td>
</tr>
</tbody>
</table>
Camera Limitations

The following is a list of general limitations with all cameras, followed by a list of camera limitations by manufacturer. For more detailed limitations, check the Avid Web site. To go to the Avid Web site, see “Decks and Cameras” on page 33.

General Limitations

- The Eject button in the Record tool typically doesn’t work on most cameras.
- Many cameras are not capable of performing a digital cut. Most, but not all, PAL cameras do not support DV In. Therefore, you cannot perform a digital cut or view from a Client monitor. European Union taxation laws specify that a DV camera that has a DV record-back function carry the same tax as a VHS recorder, which is higher than a camera tax. In the past, most of the major DV camcorder manufacturers have chosen to sell DV camcorders in Europe with DV OUT only enabled.
- Digital-8 cameras (including the Sony DCR TRV310) do not recognize timecode on Hi-8 tapes.
- If your camera is connected to your computer and the Avid Xpress DV application is running for a long period of time, large blocks of pixels might appear on your display monitor.

Workaround: Turn the camera off, and then turn it on again.
- Single-frame or single-field stepping in the Record tool or Digital Cut tool will work only if the camera connected is in Pause mode.
- Frame accuracy may be off with various cameras when you perform a digital cut.
- With a camera connected, in Frame view in the Bin, some of the frames do not play when you reduce the size. There are eight possible sizes to display when using Ctrl+K and Ctrl+L; the five smallest do not play. These sizes display properly when a camera is not connected.
• Avid testing encountered several problems with the Canon and Panasonic cameras.

Table 4  Camera Limitations

<table>
<thead>
<tr>
<th>Manufacturer/Model</th>
<th>Limitation</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Sony</strong></td>
<td></td>
</tr>
<tr>
<td>DCR-310e</td>
<td>When you are performing a digital cut with short insert edits, the last frame will be repeated.</td>
</tr>
<tr>
<td>DCR-TRV310e and TRV900e</td>
<td>Using insert edit during digital cut will break the continuous timecode on a black-striped tape.</td>
</tr>
<tr>
<td>DCR-TRV310</td>
<td>Tapes from this camera produce jittery lines at the top of your video.</td>
</tr>
<tr>
<td>DCR-TRV900e</td>
<td>Cannot perform an insert edit of less than 2 seconds.</td>
</tr>
<tr>
<td>DCR VX1000e</td>
<td>No DV In feature: digital cut does not work. The Client monitor in Overlay mode does not work.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th><strong>Canon</strong></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>All models</td>
<td>Canon cameras do not reliably find IN and OUT points.</td>
</tr>
<tr>
<td>All models</td>
<td>Canon cameras produce a blue flash intermittently during playback.</td>
</tr>
<tr>
<td>XL1</td>
<td>Cannot record timecode accurately with more than 40 minutes of video.</td>
</tr>
<tr>
<td>DM XL1</td>
<td>Intermittently produces error when performing a digital cut, even if the tape is properly black striped. Failed frame accuracy test.</td>
</tr>
<tr>
<td>DM MV20</td>
<td>No DV In feature.</td>
</tr>
</tbody>
</table>
Using a Sony DVMC DA1 or DA2 Transcoder

The transcoder has two buttons: Analog In and DV In. When you turn the transcoder on and press Analog, the light changes to green. The green light indicates a 32-kHz audio sample rate. If you press the Analog button and hold it for about 5 seconds, the light will change to red. The red light indicates a 48-kHz audio sample rate. To return to 32-kHz, press and hold the Analog button again. (You can switch back and forth by pressing and holding it.)

After you record your material and try to play it, you will see static on the screen. Switch the transcoder to DV In to see and play your media. If you want to record again, switch back to Analog In.

Table 4 Camera Limitations (Continued)

<table>
<thead>
<tr>
<th>Manufacturer/Model</th>
<th>Limitation</th>
</tr>
</thead>
<tbody>
<tr>
<td>ELUR</td>
<td>Can’t find the preroll timecode during digital cut.</td>
</tr>
<tr>
<td><strong>Panasonic</strong></td>
<td></td>
</tr>
<tr>
<td>All models</td>
<td>When Avid Xpress DV is connected to a Panasonic camera, single-frame stepping is very slow.</td>
</tr>
<tr>
<td>AG-EZ30U</td>
<td>Digital cut is not frame accurate.</td>
</tr>
<tr>
<td>PV-DV910</td>
<td>Can’t find the preroll timecode during digital cut.</td>
</tr>
</tbody>
</table>
Black Striping Your Tape

Before you perform a digital cut, you must black stripe your tape:

1. Rewind the tape to the point where you want to begin the black stripe. Put the camera into record pause mode. You will have to do this manually, without deck controls.

2. In Avid Xpress DV, load a clip with audio into the Timeline.

3. Deselect video, and select audio (both tracks) in the Track Selector panel.

4. Play the clip for a few frames and stop.
   
   In your Client monitor, you should see a black frame. Once you stop, there should be silence. At this point, the Canopus™ card is sending silent, black frames out to the DV port. That’s what you will use to stripe your tape.

5. Press pause to start the camera recording.

6. Stop the camera at whatever point you want to stop the black stripe.

   The silence that you record will be at whatever sample rate your current project setting is.

Warning Regarding Your Application Key

The application key, commonly referred to as a dongle, allows the Avid Xpress DV software to run on your system. Protect your application key from loss or theft; your Avid Xpress DV software does not function without it, and acquiring a new key from Avid involves a fee.
Screen Resolution

Avid recommends using a Desktop Area of 1024 by 768 pixels and a Refresh Frequency of 75 Hertz as your screen resolution when running the Avid Xpress DV application.

To select these settings:

1. Right-click on the desktop.
2. Choose Properties from the shortcut menu.
   The Display Properties dialog box appears.
3. Click the Settings tab.

Using Headphones with Avid Xpress DV

The Avid Xpress DV system offers a single analog audio output connection that can be used for various purposes, depending upon the needs of the individual user. For example, the analog output could be used to drive a separate mixing console or it could be used to drive a set of headphones for audio monitoring.

To facilitate the calibration of external audio devices like mixing consoles in a repeatable, consistent manner, the application automatically sets the analog output to a predefined level (–10 dBu = –14 db FS = 0 VU). This level is likely to be unsuitable for normal headphone listening.

警告 If you are using headphones connected directly to the analog output of Avid Xpress DV, you should always test audio playback levels with the headphones held some distance away to protect your hearing each time you start Avid Xpress DV.

If the level is unacceptable, you can modify it by using the Volume slider in the Windows NT system tray or by using the Master Volume slider in the Windows NT Audio Mixer application. For more
information, see “Using the Volume Slider Display in the Windows NT System Tray” on page 40 or “Using the Master Volume Slider in the Windows NT Audio Mixer Application” on page 41.

Neither of these level-setting tools affects the audio output levels of a digital device, such as a DV camera. Specifically, they will have no impact on the audio output digitally during a digital cut.

In addition, other third-party applications with volume controls, such as media players, will affect the analog output level. That level will remain unchanged even after switching back to Avid Xpress DV. If you use an external mixer to return to pre-calibrated settings after using one of these third-party applications, quit and then restart the Avid Xpress DV application.

Using the Volume Slider Display in the Windows NT System Tray

You can control the volume by clicking the Speaker icon in the system tray and by adjusting the slider that is displayed.

If the Speaker icon does not appear in the system tray, you can enable it in the Multimedia Control Panel.

To access the Multimedia Control Panel:

1. Click the Start button.
2. Point to Settings and click Control Panel.
3. Click the Audio tab.
4. Select the “Show volume control on taskbar” option in the Playback area.
   A check mark should appear in the check box.
5. Click OK.

   When the Speaker icon appears in the system tray, click it to open a slider to control the analog output level.
Using the Master Volume Slider in the Windows NT Audio Mixer Application

The Master Volume slider can be used for controlling the analog audio output level.

To access the Master Volume slider in the Windows NT Audio Mixer application:
1. Click the Start button.
2. Point to Programs, Accessories, Multimedia, and click Volume Control.

Using an Audio Mixer

When using an audio mixer with Avid Xpress DV, you should use shielded audio cables to connect the mixer to your computer. If you don’t use shielded audio cables, excessive noise might occur in the audio output during audio scrubbing.

Audio Issues

The following are audio issues that you should be aware of.

Audio Tool Input Slider

The input slider in the Audio tool does not have a scale on it. The unity gain point is correct only for an analog line, and not for a CD, microphone, or the IEEE 1394 standard FireWire. The slider cannot be used to completely silence audio; the hardware does not have enough range to do this. Therefore, the lowest value on the slider is not equal to minus infinity.
Offspeed Play to Camera

Certain speeds cannot be played back to the camera. Playing in reverse or fast forward is not possible. If you are playing back to the camera and change the speed, playback will change from the camera to the consumer audio chip, until the playback stops or returns to a normal speed the camera can handle. This switch can affect the Mix mode if you are playing in Direct Out mode, at 32 kHz, to the camera. Direct Out mode is available only when more than two audio output buses are available (which can happen only when playing to a camera at a sample rate of 32 kHz).

Third-Party Applications

This section contains information about third-party applications that work with Avid Xpress DV.

Sonic Solutions

Included with the Avid Xpress DV system is a Sonic Solutions CD-ROM that includes DVDit!™ LE. DVDit! is a DVD authoring tool. To use DVDit! with your Avid Xpress DV system, install the DVDit! application from the CD-ROM provided by Avid. To run this application, use the serial number supplied on the label attached to the CD-ROM sleeve.

Sonic Solutions offers other versions of DVDit!.

To upgrade DVDit!:
1. Click the Goodies icon on your desktop.
2. Double-click the DVDit!.html file. Click the Web link.
   OR
1. Install the Avid Xpress DV application CD-ROM.
2. Click Browse CD.
3. Double-click the Goodies folder.
4. Double-click the DVDit!.html file. Click the Web link.

This connects you to the Sonic Solutions Web site.

To view MPEG-2 files, Sonic Solutions also provides an MPEG decoder for playback. If you do not have a decoder installed already, you might want to install this. If your system has a DVD drive (external or internal), then a decoder is already installed.

**RealPlayer**

Avid Xpress DV does not ship with RealPlayer®, but you can download this application for free from the RealNetworks Web site at www.real.com.

**Canopus**

The DV Raptor board is the digital video board that inputs and outputs the digital video to and from the Avid Xpress DV system. This board is installed in your system. The Canopus software (driver and dll) is installed automatically with the Avid Xpress DV application. If you receive the message “Failed to create empty document,” the dll can’t be found. If you receive the message “Failed VPOpen,” the driver isn’t running. You should reinstall the Canopus software by reinstalling the Avid Xpress DV application.

In addition, if you are having problems recording from a camera or deck, and you think it could be the video board, there is a Canopus utility you can run to help determine if the problem is the video board.

To run Rap Navi:

1. Quit the Avid Xpress DV application.
2. Connect your camera or deck.
3. Turn the camera or deck on.
4. Click the Start button.
5. Point to Program, Avid, Utilities, and click Rap Navi.

   If the Rap Navi utility starts without any error, the board is working properly.

6. Click the Fast Forward and Reverse buttons.

7. Click the Play button.

   You should be able to see video.

**Web Software**

Two third-party applications, MPEG-Ligos and QuickTime, have been installed automatically with Avid Xpress DV. They have been modified to work properly with Avid software. Downloading newer versions of these applications before they are supported by Avid might cause problems. Avid recommends not updating these applications until they are officially supported by Avid.

For updated information, check the Avid Web site:

   2. Click Customer Service.
   3. Click Knowledge Center.

**Suggestions for Optimum Performance**

Windows NT is a multitasking operating system. However, background tasks can interrupt time-critical operations, such as recording, playing, or rendering. Make sure that background tasks are not running while you are working in the Avid Xpress DV system.

The following list contains suggestions for ensuring optimum performance when working with the Avid Xpress DV system:

- Do not leave a Windows NT Explorer window open. Windows NT Explorer will try to update file information.
• Do not schedule automatic backups at times when your Avid Xpress DV system might be in use.

• Do not leave other applications open. Some applications, such as Microsoft Office, run background processes.

• Do not allow the Find Fast background process (find.exe) to run. The process will try to update its cache of file and folder locations. Check your Startup folder and delete the file if it is there.

• Do not leave an e-mail application open if it is set to do periodic checks for mail.

• Do not run any application that includes prescheduled or automatically scheduled activities, such as a calendar program.

• Disable screen savers.

• Do not transfer network data during critical operations.

• Do not insert a CD-ROM in a drive during time-critical operations. Most CD-ROM drives and software perform an autoscan or autostart operation. The Avid Xpress DV system is shipped with autostart disabled.

• Do not keep media on the 9-GB internal system drive.

• Always use small fonts to avoid missing characters in the application dialog boxes. To review font settings, click the Settings tab in the Display Properties dialog box.

• Do not use large graphics as wallpaper.

• Clear Visual settings in the Plus! tab in the Display Properties dialog box.
Documentation Changes for Avid Xpress DV Release 1.0

The following information was omitted or has changed in the Avid Xpress DV Release 1.0 documentation.

**Avid Xpress DV Getting Started Guide**

The *Avid Xpress DV Getting Started Guide*, page 8-10, step 3 should read:

Mark an IN point at 00:00:30:00 (NTSC) or 00:00:30:00 (PAL). Check the Mas timecode display in the Composer monitor to help you mark the IN point.

**Avid Xpress DV Online Publications CD-ROM**

The *Avid Xpress DV Online Publications* CD-ROM allows you to display Avid Xpress DV documentation on your system. This is done with Adobe® Acrobat®. When you display Avid Xpress DV documents with Adobe Acrobat Reader 3.0 or 4.0, callout lines pointing to illustrations might appear bolder than others. This is a screen display problem only. All callout lines will print correctly.

If you already have Acrobat Reader 3.0 installed on your system, you can use the installer on the CD-ROM to upgrade to Acrobat Reader 4.0. If you want to view the movies in the *Avid Xpress DV Effects Guide*, you need to upgrade.

**Avid Xpress DV User’s Guide**

The following features have changed since the *Avid Xpress DV User’s Guide* was printed.
The Avid Calculator

In Chapter 4 of the *Avid Xpress DV User’s Guide*, the guide incorrectly states that the Avid Calculator “converts a duration in video to the corresponding length in footage and frames for measuring 35mm film.” This is not a feature with Avid Xpress DV.

Video Display Adjustments

In Chapter 11 of the *Avid Xpress DV User’s Guide*, the note after the Video Display Adjustment table should read: “You can reset the appearance to the Avid Xpress DV default settings by selecting the setting, by right-clicking the mouse button, and by choosing Restore to Default from the pop-up menu.” There is no Restore to Default button.

MediaLog and Avid Xpress DV


Avid Products Collaboration Guide Addendum

The following Export templates are included with Avid Xpress DV but were omitted in the *Avid Products Collaboration Guide Addendum*. You can find the *Avid Products Collaboration Guide Addendum* on the *Avid Xpress DV Online Publications* CD-ROM.

QuickTime Sorenson

**Settings:** QuickTime movie, Use Marks, Video and Audio, 160 x 120 pixels, Even Field, RGB levels Quality Low, Frame rate 15 fps, QDesign Music at 22 kHz, 16-bit Mono.
For Delivery to: This codec produces excellent Web video suitable for playback on any Pentium® or Power Mac™. Sorenson Video™ generally achieves higher image quality at a fraction of the data rate of many other codecs. Requires a fast computer for playback.

**QuickTime Sorenson Streaming**

*Settings:* QuickTime movie, Use Marks, Video and Audio, 160 x 120 pixels, Even Field, RGB levels Quality Low, Frame rate 15 fps, QDesign Music at 22 kHz, 16-bit Mono, hinted streaming setting.

For Delivery to: Same as Standard Sorenson with the addition that Apple® QuickTime servers allow this file type to stream in real time to the end user.

**Other Avid Applications**

AvidNet™ Transfer Tool Release 3.5 and EDL Manager Release 9.1 are included as separate installers on the Avid Xpress DV CD-ROM.

To install these applications:

1. Click Installers on the Avid Xpress DV CD-ROM.
2. Click the application you want to install.

For information on how to use these applications, see the *Avid Xpress DV Online Publications* CD-ROM, which includes the *AvidNet Transfer Tool User’s Guide* and the *Avid EDL Manager’s User’s Guide*. These guides are available for viewing through Acrobat Reader 4.0 (provided on the Online Publications CD-ROM). In addition to the user’s guides, each of these applications includes its own Help system.

The following sections address specific issues related to each of these products.
AvidNet Transfer Tool

Before installing the AvidNet Transfer Tool, you should first install any other Avid applications on the system. The installer can find media drives already configured on the system only if you install the AvidNet Transfer Tool last.

Special Notes

The following sections provide information not available in the AvidNet Transfer Tool User’s Guide.

The Consolidate Feature

The Consolidate feature is not available with Avid Xpress DV at this time.

Destination Directory Considerations

All AvidNet Transfer Tool options are saved in the Windows NT registry under the account of the currently logged-in Windows NT user. These options include settings such as column sizes, destination directories, and destination systems. They are not transferred between user accounts. If different users will be logging in to the operating system and using the AvidNet Transfer Tool, make sure to define settings for each user.

Defining settings for each user is important in the Destination Directory options, which are set during installation. For example, if you log in as a different user and try to use the AvidNet Transfer Tool, you will not have the same options that were set during installation.

Do one of the following to allow the installation to set up the directories for a user:

- Log in as the user who installed the AvidNet Transfer Tool, make note of the settings under “Options - Directories,” and then
change the settings under the AvidNet Transfer Tool logged in as the new user.

- Reinstall the AvidNet Transfer Tool, logged in as the new user.

**Transferring Files**

Bin, composition (without media), and full composition transfers are supported between Avid Xpress DV and other Avid editing systems using AvidNet. However, when you are sending media (full compositions), the media should be compatible with the destination system. Otherwise, the media will arrive, but will produce an error and will not play.


**Avid EDL Manager**

The following features were introduced in the previous release of Avid EDL Manager and are now part of Release 9.1:

- **Template creation and selection:** You can now create temporary templates and save them in the Options window. Temporary files as well as saved template files are listed in the Template pop-up menu in the EDL Manager window.

- **Record Start Time option:** Instead of automatically taking the record start time for the EDL from the sequence, you can set the record start time or take it from the sequence.

- **Serial transfer options:** Serial transfer options are located in the Site Settings dialog box that can be opened from the Edit menu.

- **Detection of video standards:** EDL Manager automatically detects the video standard when you open an OMFI file or a bin. If
you open a text EDL, use the Video Standards menu in the Options window.

**Special Note**

Only four channels of audio are available in the following circumstances:

- When you save your EDL to an OMFI composition
- When you create a sequence from your EDL by choosing Create Sequence from the File menu

To save or create more than four channels, generate multiple sets of audio EDLs. For example, generate an EDL for channels A1–A4, generate another EDL for channels A5–A8, and so on.

**Avid Unity MediaNet**

Avid Unity MediaNet allows you to have multiple clients. If one client deletes media from his directory, the media is also deleted from the other clients’ directories. However, each client needs to refresh his machine for the change to update across all clients.

After you delete media, choose Refresh Media Directories from the File menu on each client machine to update the database.

OMFI media files are not found within MediaNet.
Additional Notes on Operation

For specific issues with cameras, see “Camera Limitations” on page 35.

Audio

To start an AudioSuite plug-in, you must be logged in with administrator privileges. If you are not logged in as an administrator, you will get the following error when you try to start the AudioSuite plug-in: DAE ERROR: DAE error-1113 occurred.

You can’t choose an input source from the Audio Project Settings window for Audio Punch-In if deck control is enabled in the Record tool.

Workaround: Disable deck control in the Record tool, and then choose an analog input source from the Audio Project Settings window.

The Audio Project Settings window contains incorrectly labeled text boxes. The Incoming and Outgoing text boxes are reversed, which causes the incoming and outgoing audio frame information you specify to be reversed.

Workaround: To adjust Digital Scrub parameters in the Audio Project Settings window, enter incoming frames in the Outgoing text box, and enter outgoing frames in the Incoming text box.

Bins

The Tape ID column in a Bin view does not get saved when a bin is closed and reopened.

Workaround: Select the Tape ID again in the Headings menu.
Editing

A heavily edited sequence might cause a low virtual memory message when loaded in the Composer monitor.

Workaround: Click OK when you receive the error message. Quit Avid Xpress DV and reboot your system. You can increase the paging file when your virtual memory is low; see “Increasing the Paging File” on page 30.

Effects

A long video mixdown with multiple unrendered effects might cause an insufficient memory error.

Workaround: Render the effects first, and then perform a video mixdown.

Changes to a nested effect do not update in the monitor until the top effect is rendered.

Export

You can’t export a 16:9 file format to Media Cleaner EZ.

You can’t export a 16:9 file format to MPEG-Ligos.

An access violation might occur when exporting to MPEG-Ligos.

When exporting an MPEG-Ligos sequence at 48 kHz, the audio will drop out (approximately 26 frames) at the end of the movie.

Workaround: Change the project setting to 44.1 kHz before you export.
Exporting and importing OMFI Web compositions to and from a Macintosh system will cause the Hue, Saturation, and Luminance sliders in the Effect Editor to slip to the wrong values.

**Workaround:** Note your values before importing or exporting and then readjust the sliders.

When exporting a QuickTime DV stream file at 32 kHz, make sure you select “Audio format locked” in the QuickTime Codec Options dialog box. If you don't, you will have audio dropouts when you play the file in the QuickTime Player.

### Media Files

Media files deleted from the OMFI MediaFiles folder (located outside the application) do not display as “Media Offline” properly.

**Workaround:** Delete the media databases and rebuild them for the offline functionality to work properly. Quit the Avid Xpress DV application. Locate the OMFI MediaFiles folder. Delete the .pmr and .mbd files. Start the Avid Xpress DV application. The media database rebuilds when you start the application.

### Recording

The emptiest drive does not always appear bold in the Record tool.

Before recording or performing a digital cut to a DV device, connect the DV device first and then turn it on. Wait a few seconds before recording.
Third-Party Applications

A RealMedia™ file having two periods in a row in the file name will cause RealPlayer 7 to crash when you play a file exported from Avid Xpress DV.

The Reveal File command in Avid Xpress DV does not work with Windows Explorer 4.7. If you set your view to Web Style and don’t enable Classic Desktop or set your view to Custom and don’t enable Classic Desktop, the Reveal File command does not work.

Workaround: Change the settings in Windows NT Explorer.

When using Classic Desktop:
2. From the View menu, choose Folder Options.
3. Click the General tab.
4. Select Classic style.
5. Click OK.

When using Custom Desktop:
2. From the View menu, choose Folder Options.
3. Click the General tab.
4. Click Custom, based on settings you choose.
5. Click the Settings button.
6. For the Active Desktop, select Use Windows classic update.
7. Click OK.
8. Click Close.
Copyright and Disclaimer

Product specifications are subject to change without notice and do not represent a commitment on the part of Avid Technology, Inc. The software described in this document is furnished under a license agreement. The software may not be reverse assembled and may be used or copied only in accordance with the terms of the license agreement. It is against the law to copy the software on any medium except as specifically allowed in the license agreement. Avid products or portions thereof are protected by one or more of the following United States patents: 4,746,994; 4,970,663; 5,045,940; 5,063,448; 5,077,604; 5,245,432; 5,267,351; 5,309,528; 5,325,200; 5,355,450; 5,393,594; 5,440,348; 5,452,378; 5,467,288; 5,513,375; 5,520,310; 5,557,423; 5,568,275; 5,577,190; 5,584,006; 5,627,765; 5,634,020; 5,640,601; 5,644,364; 5,654,737; 5,701,404; 5,715,018; 5,719,570; 5,724,605; 5,726,717; 5,729,673; 5,731,819; 5,745,637; 5,752,029; 5,754,180; 5,754,651; 5,781,188; 5,799,150; 5,812,216; 5,828,676; 5,842,014; 5,834,385; 5,837,670; 5,839,212; 5,839,226; 5,849,532; 5,892,507; 5,905,841; 5,913,676; 5,916,766; 5,929,436; 5,950,742; 5,950,744; 5,930,445; 5,930,797; 5,946,445; 5,966,134; 5,977,982; 5,986,584; 5,987,501; 5,995,079; 5,995,115; 5,999,190; 5,999,406; 6,009,507; 6,011,562; 6,014,150; 6,016,152; 6,016,380; 6,018,337; 6,023,531; 6,032,703; 6,031,529; 6,035,367; 6,038,573; 6,052,508; 6,058,236; 6,061,758; 6,072,786; 6,325,279; 6,372,478; 6,373,776; 6,392,287; 6,392,288; 6,392,289; 6,395,291; 6,396,853; D398,912. Additional U.S. and foreign patents pending. No part of this document may be reproduced or transmitted in any form or by any means, electronic or mechanical, including photocopying and recording, for any purpose without the express written permission of Avid Technology, Inc.

© 2000 Avid Technology, Inc. All rights reserved. Printed in USA.

Attn. Government User(s). Restricted Rights Legend

U.S. GOVERNMENT RESTRICTED RIGHTS. This Software and its documentation are “commercial computer software” or “commercial computer software documentation.” In the event that such Software or documentation is acquired by or on behalf of a unit or agency of the U.S. Government, all rights with respect to this Software and documentation are subject to the terms of the License Agreement, pursuant to FAR §12.212(a) and/or DFARS §227.7202-1(a), as applicable.

Trademarks

AirPlay, AudioVision, Avid, Avid Xpress, CamCutter, Digidesign, FieldPak, Film Composer, HIIP, Image Independence, Marquee, Media Composer, Media Recorder, NewsCutter, OMFL, OMFL Interchange, Open Media Framework, Pro Tools, Softimage, and tools for storytellers are registered trademarks and 888 I/O, AniMatte, AudioSuite, AutoSync, AVIDdrive, AVIDdrive Towers, AvidNet, Avid Production Network, AvidProNet, AVIDstripe, Avid Unity, AVX, DAE, D-FI, D-FX, D-Verb, ExpertRender, FilmScribe, Intraframe, iS9, iS18, iS23, iS36, Lo-Fi, Magic Mask, Matador, Maxim, MCXpress, MEDIArey, MediaDock, MediaDock Shuttle, Media Fusion, Media Illusion, MediaLog, Media Reader, MediaShare, Meridien, NaturalMatch, OMM, Open Media Management, QuietDrive, Recti-Fi, rS9, rS18, Sci-Fi, Sound Designer II, Symphony, Vari-Fi, and Video Slave Driver are trademarks of Avid Technology, Inc.

Adobe and Acrobat are trademarks of Adobe Systems Incorporated. Apple, FireWire, and Macintosh are trademarks of Apple Computer, Inc., registered in the U.S. and other countries. Canon is a registered trademark and ELURA is a trademark of Canon Inc. DVD! is a trademark of Sonic Solutions. Canopus is a trademark and DV Raptor is a registered trademark of Canopus Corporation. IBM and IntelliStation are registered trademarks of International Business Machines Corporation. Intel and Pentium are registered trademarks of Intel Corporation. Media Cleaner is a registered trademark of Media 100, Inc. Microsoft, Windows, and Windows NT are registered trademarks and Windows Media is a trademark of Microsoft Corporation. Panasonic is a registered trademark of Matsushita Electric Industrial Company. Limited. Power Mac and QuickTime are trademarks of Apple Computer, Inc. RealPlayer is a registered trademark and RealMedia and RealProducer are trademarks of RealNetworks. Sony is a registered trademark of Sony Corporation. Sorenson Video is a trademark of Sorenson Vision, Inc. All other trademarks contained herein are the property of their respective owners.
Avid Xpress DV for the Windows NT Operating System What's New for Release 1.5 •
Part 0130-04645-01 Rev. A • August 2000

Avid

tools for storytellers®